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The following changes have been made to DAT/EM products between Release 7.2 and Release 7.3. Please review these 
revisions made to the software and update your software to implement changes. 
 
As always, DAT/EM welcomes comments and suggestions from you, our clients, so please do not hesitate to contact our 
support department at support@datem.com or call us with your requests. 
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Operating Systems and Microsoft Updates 
Release 7.3 is supported on the following operating systems: 

 Windows 7 Ultimate and Professional with all Windows Updates applied. 

 Windows 8.1 Professional and Enterprise with all Windows Updates applied. 

 Windows 10 Professional and Enterprise with all Windows Updates applied. Windows 10 notes: 

o DAT/EM software installs and works in Windows 10, but it is the client’s responsibility to be sure stereo 
can work in Windows 10. 

o Use a graphics card that has an OpenGL version 4.2 or higher. DAT/EM will not test Windows 10 with 
video cards that have older OpenGL versions. (Hint: Even the lower-end nVidia K2200 and M2000 are 
far superior to the older cards such as the Quadro FX4800, so please replace these old cards.) 

o For DAT/EM stereo applications, install the newest nVidia video driver bundle using the “custom” and 
“clean” installation choices. Turn off automatic video driver updates in Windows 10. 

o Always keep Windows 10 Updates current.  

o More Windows 10 hints are found in the Tech Tips section of www.datem.com.  

 
Microsoft Office 2007 users must install all available Microsoft Office updates before installing any version of DAT/EM 
software. 

 
Hint: If you have Windows 8.1 or 10 and you miss the Windows 7 Start menu, you may be interested in the third-party 
“Classic Shell” application. We use it on our DAT/EM computers and tablets and we really like it. Classic Shell™: 
http://www.classicshell.net/  
 
 

Hardware Locks/Dongles 
Please install Microsoft Updates and OS Service Packs before applying lock reset programs. Network licensing should 
have the same Sentinel driver version on both the server and the local computers running the software. 
 

1. DAT/EM changed its hardware lock configuration with the release of version 7.1. If you have a hardware lock that 
was “written” by DAT/EM 13 August 2014 or earlier and you did not install version 7.1 or 7.2, you will need to 
apply a WriteLock.exe to update the lock for v.7.3. This prepares the lock to work for version 7.1, 7.2, or 7.3 
created 14 August 2014 or later. The newly written lock is not backwards compatible with version 7.0 or earlier. If 
for any reason you want to return to v.7.0 or earlier, please ask DAT/EM for a v.7.0 WriteLock. 
 

Q: I have been using DAT/EM version 6.8 or 7.0. Do I need to apply a WriteLock? 
A: Yes! You need both a new WriteLock (from 7.1, 7.2, or 7.3) and a 7.3 installation keycode. 
 
Q: I have a network lock that is currently running v.7.0 or earlier. Do I need to apply a WriteLock before I 
install version 7.3? 
A: Yes! You need both a new WriteLock (from 7.1, 7.2, or 7.3) and a 7.3 installation keycode. Don’t forget 
to update the Sentinel driver on your network lock server to 7.6.8 if it currently has an older version. 
 
Q: I am currently running the release version of 7.1 or 7.2. Do I need to apply a WriteLock for 7.3? 
A: No. A lock that works for 7.1 or 7.2 will still work for 7.3. 
 
Q: I have a softlock demo. Do I need to apply a WriteLock? 
A: No. The WriteLock does not apply to softlocks. You may upgrade to version 7.3 using a 7.3 installation 
keycode only. If you change to a hardware lock later, DAT/EM will pre-write your new hardware lock to 
work with version 7.3 or the older version of your choice. 
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2. The Safenet Sentinel driver version 7.6.8 is provided with DAT/EM version 7.3. It is the same version that was 

provided with 7.2. If version 7.2 or 7.3 (release or beta) dated after August 3, 2015 was not previously installed, 
then the first run of the DAT/EM self-extracting executable will install or update the Sentinel driver. Please reboot 
when asked. 
 
If you have a network lock on a network server and it is not already running Sentinel v.7.6.8, install it on the server 
before you install DAT/EM v.7.3 on your DAT/EM workstations. The Sentinel driver version must match on the 
network lock server and all workstations that will access the lock. There are three choices for installing the driver 
on the network server (choose A, B, or C): 
 

 Choice A) Run the DAT/EM “Setup…exe” file one or two times on the network server. The first time it 
runs, it may install C redistribution files and may require a reboot; if so, run DAT/EM “Setup…exe” again. 
It will then install the Sentinel driver. Answer “Yes” to the firewall question. Reboot if asked. 
 

 

It is very important to answer “Yes” to this question 

 
 Choice B) Download and install version 7.6.8 from the Gemalto/Sentinel website: 

https://sentinel.gemalto.com/support_and_downloads/Download_Drivers/Sentinel_Drivers/  (note that the 
driver posted there could be updated beyond 7.6.8 at any time. If you want to use a newer driver, you 
must install it on all your DAT/EM workstations and on your network lock server.) During installation, 
answer “Yes” to the firewall question as shown above. 
 

 Choice C) Download version 7.6.8 from the DAT/EM website: 
http://www.datemsystems.com/down/drivers/Sentinel%20Protection%20Installer%207.6.8.exe. During 
installation, answer “Yes” to the firewall question as shown above. 
 
 

 

Stereo Viewing Devices 
No changes or additions have been made to the list of compatible stereo viewing devices. 
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Video Drivers 
Please note our video driver installation/update recommendations: 

 DO NOT install the driver on media packaged with a video card. It will be too old. 

 1st: Get the latest driver for your video card and operating system from www.nVidia.com. During installation, select 
“Custom (Advanced)” and “Perform a clean installation”. 

  

 2nd: If the driver on www.nvidia.com does not work, contact support@datem.com for advice. We may ask you to 
download an older driver from either www.nvidia.com or www.datem.com depending on your hardware and 
operating system. 

 If you need to change (update or back out) a video driver, please follow the instructions at www.datem.com 
Support > Downloads > Manuals > Installation Instructions>“StereoLCDInstallationInstructions.pdf”. This 
shows how to replace drivers and verify that the new drivers are properly installed. It is very important to check on 
the “Custom” and “Clean” installation choices shown above. 

 On existing workstations, check your video driver periodically. The easiest schedule is to check it before installing 
each DAT/EM software update. If you use a single-panel LCD display and the video driver is older than the one 
currently offered at www.nvidia.com, please update it using the “Custom” and “Clean” installation options. 

More notes: 

 When checking your installed video driver version, remember that the actual version consists of the last five digits 
with the decimal point moved two spaces to the right. For example, 6.14.12.7642 is really version 276.42. In the 
past, nVidia sometimes omitted a zero (0) from the version; for example, version 6.14.13.732 was really 307.32. 

 For video settings, see www.datem.com Support > Downloads > Manuals > Installation Instructions. Most 
users will want either “PlanarInstallationInstructions.pdf” for Planar dual-LCD monitors or 
“StereoLCDInstallationInstructions.pdf” for single LCD stereo monitors. 

 
 

Software Installation, File Locations, and Installed Utilities 
The following has changed for DAT/EM software installation or the location where DAT/EM applications store data: 

Note: Blue Marble's Geographic Calculator ArcGIS plugin directly conflicts with DAT/EM's CaptureArcInfo.2010.dll. 
When DAT/EM software is installed, "Registration Failed" is reported near the end of installation. Run "C:\Program 
Files (x86)\Blue Marble Geo\Geographic Calculator\UnRegisterEsriPlugin.bat" before installing DAT/EM software. 
Contact DAT/EM for more information if you have Geographic Calculator and would like to use it in ArcGIS. 

1. Silent installation mode is now available. Silent installation mode can be useful when installing or upgrading the 
same version of Summit to a large group of similar computers, such as at a University computer lab. For more 
information, see the silent installation mode installation document available on www.datem.com. 
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2. The installation process for Capture for ArcGIS will no longer show a “Register” dialog. This was an Esri ArcGIS 
extension registration dialog, and DAT/EM has found a way to suppress it successfully. This was done so that the 
silent installation mode mentioned above will work. 

 
Please note that in a certain percentage of cases, ArcGIS fails to register the DAT/EM extension properly at the 
end of DAT/EM software installation. This happens whether the registration is silent or not. The only solution we 
know to be successful is to reinstall ArcGIS, make sure it is licensed, and then reinstall DAT/EM software. 

 

3. On 64-bit computers, the entire 32-bit application set will no longer be installed. The “C:\Program Files 
(x86)\Datem Software” folder will still be used for those DAT/EM applications that only have a 32-bit version, such 
as the Keypad Controller. 

4. DAT/EM’s Capture for Global Mapper extension is no longer enabled by default. After running DAT/EM’s 
installation, customers wishing to enable the extension must run the CAD Enabler. 

There are installations where Global Mapper may appear to fail after software installation. An example of this 
failure follows. 

 

Potential crash due to problem in Global Mapper’s extension registration process 

If this error is encountered: 1) Verify that the version of Global Mapper is version 17.1.2 or higher. 2) Run Global 
Mapper and check for the DAT/EM toolbar. If the toolbar is there, the installation was successful and you can 
disregard the error. 3) If the toolbar is missing, the extension can be enabled by opening Global Mapper and 
before opening any data files, select Global Mapper > Help > Module/Extension License Manager > check on 
“DAT/EM Capture for Global Mapper (version)” in the right pane. 

 

If the DAT/EM Toolbar is present, the registration succeeded 

For more information, see “DAT/EM Capture for Blue Marble Global Mapper” starting on page 49 below. 
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5. The Release Information dialog’s Copy button will also ask if you would like to run Windows DxDiag, which 
creates a text report about the computer and video card. 

 

Release Information’s Copy button asks to run DxDiag 

6. This change was implemented in version 6.8, but if 6.8 or higher was not installed, please take note. There is a 
newer DAT/EM-PCI Runtime ProPack installation to install after installing version 6.8 or higher. Download the file 
at www.datem.com and install it. It will launch the PCI License Utility, which contains a fingerprint and a link to a 
web request form. Copy the fingerprint and use the link to send the fingerprint to PCI. 

 

PCI will send a license file. Rename the file to “lservrc.txt” and copy it to the 32-bit location: 

 \Program Files (x86)\Datem Software\ProPack\exe 

Run the following file in the 32-bit locations.  

 \Program Files (x86)\Datem Software\ProPack\exe\LaunchLicenseUtil.bat 

Select the “Import” button, and browse for the “lservrc.txt” file in that same folder. Information will appear in the 
license file list below the “Import” button. Close. 

 

Select “Import” and browse for lservrc.txt 
 
 
PIX images should now open in Summit when Summit is launched from Windows Start > All Programs > Datem 
Software > PCI ProPack > Summit 64 with Propack (64-bit) or Summit 32 with Propack (32 bit), which launch 
Summit from the LaunchSummitWithPropack.bat files in the corresponding 64- or 32- bit applications folders. If 
they continue to give license errors, please contact DAT/EM Support. 
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DAT/EM Virtual Reality 
The following changes or additions have been made to the list of compatible virtual reality devices: 

1. The release version of the Oculus Rift is supported. 

2. The VR Desktop is still installed, but the beta Point Viewer and other beta applications that may have been in 
v.7.2 have been removed in preparation to market them as separate products. 

 

 

DAT/EM Keypad 
The following changes have been made to the DAT/EM Keypad products: 

1. Version 7.2 had a bug in Keypad.exe for legacy Polytel keypads. The string “KDS” would be inserted into the 
command strings and then fail to execute the correct string sequence in AutoCAD. This is fixed. 

 

 

Coordinate Transformations and Elevation Database 
The following changes have been made to the DAT/EM-Blue Marble coordinate transformation selections inside Summit, 
Summit’s Control Editor, Point Translator, and any other DAT/EM application that offers coordinate translation. All the 
changes for v.7.3 are installed with the main DAT/EM setup executable file (not from the elevation database file). 

The elevation database used for v.7.3 is the same as the one used for v.7.2: “SetupElevationModels blt 03 15 2015.exe”.  

If updating from DAT/EM v.7.1 or earlier or if the elevation database has never been installed, visit 
http://www.datem.com/downloads-2/#1469568208626-68958d12-70e7 (www.datem.com > Support > Downloads > 
expand “Elevation Model Database”) and download “Elevation database versions for 7.2 and 7.3”. 

1. A significant cooperation between Blue Marble and DAT/EM has resulted in DAT/EM software being able to 
update its coordinate transformation selections much more frequently. When Blue Marble releases a version of 
Geographic Calculator, the next DAT/EM release will match it. This was a significant improvement and change, 
and it will be noticeable to the user in the following ways: 

a. If the project was created in DAT/EM v.7.2 or lower and has non-default settings in Summit > 
Orientation > Coordinate Conversion, the setting should update automatically when opened in v.7.3. 
That is, they are forward compatible. Open the coordinate conversion dialog and verify the settings, if 
desired. 

b. The coordinate system settings saved by v.7.3 in the .smtxml are not backwards compatible to earlier 
Summit version projects. To avoid time-consuming issues related to this, we recommend that you use the 
same version of DAT/EM software on all your Summit workstations. 

c. Some of the names of the systems have changed. For example, “Ellipsoid Height” is now called 
“Ellipsoidal Height”. If you have any question about whether you are selecting the correct system, please 
take screen shots of the old and new settings and send them to DAT/EM Support. We’ll contact Blue 
Marble Support for you. 

d. If you have customized coordinate systems from a previous version, you will have a Custom.xml file. 
This will be updated for use with v.7.3 when v.7.3 is installed. However, the reverse does not happen; that 
is, if you install v.7.3 and then reinstall v.7.2 or lower, the lower version will not be able to read the v.7.3-
updated Custom.xml file. If you plan to go back to a previous version, you should save your Custom.xml 
file before v.7.3 installation. Note that DAT/EM does not recommend going back to v.7.2 or lower once 
v.7.3 is installed. DAT/EM recommends upgrading to v.7.3 on all workstations. 
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2. Horizontal Time Dependent Position (HTDP) transformations are now available for systems that support it. There 
is a new date field in the Coordinate Conversion for Project dialog. 

A date field has now been added:  . 

 If the date looks like __/__/____, then it is not set (NULL date). 

 If you set a date and later want to clear it, click the dropdown button. Don’t select a date from the 
calendar; instead, click somewhere else in the dialog. 

 The date is only useful for transformations that actually support it. You can set the date for 
anything, but it will not affect systems that don’t support it.  

 You (the user) must take responsibility to know whether the system you select has a time-
dependent component and what date should be set. This is not a setting to simply guess; it is a 
setting that should be clearly documented in your project’s specifications. The Blue Marble 
website, www.bluemarblegeo.com indicates that all HTDP choices are U.S. NOAA-NGS sourced 
shifts. Please see their website for more information. 

 

New date field for Horizontal Time Dependent Position transformations 

 



DAT/EM Systems International Version 7.3 Release Notes 
 

 9 

Summit Evolution 
The following changes have been made to Summit Evolution and the applications that are provided with it.  

 
General Summit Evolution Subjects 

 

1. See the “Coordinate Transformations and Elevation Database” section above starting on page 7. 

 

2. Summit now supports two additional input devices: 

a. The Xbox One™ controller has been added to the previously supported Xbox 360®.  

 

Xbox One 

b. 3DConnexion SpaceMouse® Enterprise. This is a superior model over previous 3DConnexion devices. 
Here is a review from the software engineer who added this and previous 3DConnexion devices to 
Summit, “The mouse part is really accurate and has a good feel. The new screen is actually useful as it 
shows the commands for the top 12 buttons.  As you switch applications, you can see these change. …all 
around just a slicker feeling device [compared to previous 3DConnexion models].”  

 

3DConnexion SpaceMouse Enterprise 
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Summit will now automatically set the correct Advanced Settings: 

 

3DConnexion SpaceMouse Enterprise Advanced Settings 

Summit will now automatically set up the 3DConnection buttons. 

 

3DConnexion SpaceMouse Enterprise Buttons Settings 
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Any button set to “Application Use” will be sent to Summit as a Summit button hit. The button number 
from this dialog will not match the numbers that come up in Summit. For example, buttons 1-10 will come 
up as Summit buttons 14-23. You can use Summit and Button Manager together to set up the buttons: 

 Launch Button Manager (Summit > Tools > Button Manager). 

 Leave 3DConnexion’s Properties open, since this clearly shows which application has 
Windows focus. 

 With Summit open and when Summit has Windows focus (click on the Summit window to 
give it focus if necessary), press the button on the SpaceMouse Enterprise. Button 
Manager will automatically move to the button. 

 Assign Summit’s commands for the button. 

Troubleshooting steps may be needed if you have a previous version of 3DConnexion input device: 

 If you have an older model of 3DConnexion device, update its driver to the latest 
available from 3DConnexion. Summit now uses the latest 3DConnexion SDK, which 
works with the latest drivers. 

 If Summit does not update the keys or the advanced settings, exit Summit. Use Windows 
“regedit” to remove the following registry key: 
HKEY_CURRENT_USER\Software\DAT/EM Systems International\SpaceNav. 
After removing it, restart Summit. 

If you have this device and would like enhancements for the interface, such as showing the Button 
Manager command on the device’s display, please contact support@datem.com. 

 

3. 3DConnexion SpaceExplorer®, SpacePilot®, and SpaceNavigator® used as a Summit input device should 
update the device’s driver. Summit now uses the updated 3DConnexion SDK. 

 

4. Model Extents is a new option that is useful for very large projects. The new setting allows Summit to store the 
project extents in a binary file and read it quickly instead of recalculating the extents frequently. 

A very large project might have thousands of images. When the new option is off, the project extents are 
calculated every time the project opens and at certain other times during operation. When the new option is on, 
the extents are calculated only when the user chooses to update the extents. 

Select Summit > Orientation > Model Extents. 

 

New Model Extents prevent frequent extents calculations in very large projects 



DAT/EM Systems International Version 7.3 Release Notes 
 

 12 

 
Check on Use Model Extents from file to load the extents from the extents file. This overrides the 
Automatically load next model… option found on Summit > Tools > Options > Project. If Use Model Extents 
from file is checked on, it is like turning on Automatically load next model…, even if it was not previously on. 
 
It is not enough to only check the Use Model Extents from file box; you must also select the Save button to save 
the current extents. Depending on the current state of the project, it may or may not have extents already. Use the 
Update Extents button to calculate the project extents. For a typical large project, do the following: 

 
 Check on Use Model Extents from file. 
 Select the Update Extents button. 
 Select the Save button. 
 Select the OK button. 

 
Note: If you selected Cancel instead of OK, the check box would not apply. There would still be 
an extents file, but it would not be turned on for use. 
Note: The software engineer says that Update Extents and Save are two separate buttons for a 
very good reason, and they will not be combined in the future. 
 

The Use Model Extents from file setting also modifies the .smtxml project, so the project will need to be saved 
before or upon Summit exit. The next time the project loads, it will automatically read the extents from the file. 
 
The extents file is binary, and therefore not human readable. Its name will be <project name>_smtxml.extents 
and it is written to the same folder as the .smtxml: 

 

Example of a project and its extents file name 

It is the user’s responsibility to update the extents when the project changes. For example, after adding images to 
the project, select Summit > Orientation > Model Extents, then select Update Extents, Save, and OK. 

A symptom of an outdated extents file could be failure of the next model to open automatically when the cursor is 
at the edge of the previous model’s stereo area. Note: An incorrect opening elevation of the project is also a very 
common cause of this problem, and both causes could exist at the same time. 

 

5. The Point Collector tool has been updated. Previously, it could only read and write simple (x y z)-format text files. 
Now it offers a variety of formats. The default is a Summit .con control file. The points are automatically 
numbered, and may be edited by clicking on the field and keying in a new value. The point identifier is only saved 
to the control file format, since other formats such as .las do not support a point identifier field. 

 

Point Collector’s new Identifier field automatically numbers and can be edited 
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6. If Summit does not have a model open when a “Move Summit to picked point” is used in any of the DAT/EM 
Capture packages, Summit will now move to the picked point and open the model in that area. 

7. Summit’s SI Lidar tool has the following changes: 

a. The SI Lidar tool can now show the ranges and area for multiple selected files. Select the files in the list 
on the left and view the results on the right: 

 

Information shown for multiple selected files in the SI Lidar Tool 

b. The SI Lidar Tool can now move to the minimum and maximum range values or to the center of the 
range. Double click on the Range (min), Range (max), or Area rows to move to the coordinate or area 
center. This works for either a single file or multiple selected files as shown above. Note that if the 
coordinate is in a different model, it will open only if Summit > Tools > Options > Project tab > 
“Automatically load next model…” is on. 

 

New move capabilities in the SI Lidar Tool dialog 
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8. The Summit > Tools > Google Maps functionality could cause Google Maps to give errors due to a change made 
by Google Maps. This tool in Summit accesses web-based DAT/EM code to run the map. The code was updated 
on 16 Feb. 2016 to be compatible with the Google Maps change. All versions of Summit will work again with the 
Google Maps tool, but may require a refresh to do so. 

Note: The Google Maps tool will only work on projects that have the input system set correctly in 
Summit>Orientation>Coordinate Conversion. 

Hint: If you are using any DAT/EM version up to and including 7.3 beta or 7.3 release and receive a “Script Error” 
or other errors from Tools>Google Maps, refresh the tool as follows: 

 Do not move the Summit cursor, since moving may generate more error dialogs. 

 The application is not locked up. Answer “No” many times (hold down the “N” key continuously) until 
the error messages are all closed. Keep the Google Maps dialog on screen. 

 Click the system mouse one time on the “Google Maps” window title bar. This ensures it is the 
Windows focus dialog. 

 Press the F5 key to refresh. 

 If F5 was not enough to prevent more “Script error” messages, then close the Google Maps window. 
Open Internet Explorer (IE) and clear the cache. If you don’t know how to clear the cache, launch 
Windows Start>All Programs>Internet Explorer, press F1 for IE Help, and search for “clear the cache” 
to find instructions for your IE version. Try Summit>Tools>Google Maps again. 

 

 

How to refresh the Google Maps window in all versions of Summit 
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Aerial Projects 

9. Aerial projects have the following changes: 

a. There is a new kappa difference filter for automatic model generation. Models will not be formed between 
two images with a difference in kappa angles that exceeds the setting. 

b. For digital cameras, the camera distortion parameters will now be applied outside the image to only 1% of 
the larger of either the height or width in millimeters. Previously, it was 20%. The value will remain the 
same for film frame cameras, at 20% beyond the largest fiducial distance. The problem was that 20% was 
just too large for digital UAS cameras that had large distortion parameters, resulting in superimposition to 
display incorrectly for some vectors that originated outside the stereo area. 

c. Move to Ground has a new option to show all models that contain a certain point and optionally open the 
models in multiple viewports. It appears on a new “Model” tab. 

 Select the point on the left “Identifier” list. 

 All the models that contain the control point in both images will be displayed on the right 
“Models” list. The orientation of the models is used to determine this; it is not based on 
whether the point has a measurement. 

 To open one of the models, click on it in the list on the right. 

 To open all the models in multiple viewports, select the “Set View Ports” button. 

 

Move to Ground’s new Model tab shows and opens models that contain a control point 

d. The aerial interior corrections dialogs have enhancements to help projects with U.S. and International 
Feet (feet) units use the Use heights and Dynamic terrain height methods. These methods require 
values to be in meters. Previously, these methods did not help convert exterior values from feet to 
meters, which made it difficult to set Use heights and impossible to use Dynamic terrain height for 
projects in feet. 

Note that all three What to use in calculations options only take effect when Earth Curvature 
Correction and/or Atmospheric Correction is on. 
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Note that the Units button on the Interior Corrections dialog is the same as the Units button on the 
Interior Corrections dialog. Set it in either dialog. 

 

 

For Use heights, first set the default Flight height and Terrain height values in meters, if you intend to 
use them. Next use the Units button to set the U.S. or International Feet. Then select the Per image 
heights button and make settings in the images’ Flight (m) and Terrain (m) columns. Select the images 
to set before using the buttons below the list. 
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If you use Fill Flight Height from EO and the units are feet, it will warn you that it is converting to meters: 

 

Fill Flight Height from EO will fill the exterior Z values for selected images. It will also convert any 
“Default” settings in the Terrain column to the value of the Terrain Height setting found in the Interior 
Corrections dialog. Once this is set to a number, it will no longer change automatically if the value in the 
Interior Corrections dialog is changed. 
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For Dynamic terrain height, set the new Units button to the project units. If in feet, dynamic terrain will 
automatically convert the exterior and cursor height values from feet to meters so that it will work properly. 

Note to Trimble Inpho software users: Trimble’s Inpho version 7.1.2 will now prevent Dynamic Terrain 
from being set in the exported Summit project if the units are in U.S. or International feet. This is for 
compatibility with Summit v.7.2 and lower. If you are using v.7.3, you may manually turn on Dynamic 
terrain height, flight height of exterior and set the Units in the Inpho-exported project. 

 

 
Orthophoto Feature Collection Projects 

10. Orthophoto Feature Collection projects:. 

a. Orthophotos in MrSid format will now correctly automatically change to the next image when the cursor 
leaves the current image area. (Note that the Summit >Tools > Options > Project > “Automatically load 
next…” setting must be on for this to happen.) 

 

 
Imported Projects 

11. Imported Projects: 

a. The import process was improved for Agisoft Photoscan camera XML files. It is now better to import the 
whole-project Agisoft XML file rather than the specially exported camera-only XML file, because the 
whole-project XML file contains the camera pixel size. 

 If the whole-project Agisoft XML file is imported, it will override any value in the Camera pixel 
size (mm) field by the value read from the XML. 

 If the camera-only Agisoft XML file is imported, the user must enter the value correctly for 
Camera pixel size (mm). 

How do you know which XML file you have? If you open it in a text editor, the camera-only file may have 
approximately 15 or 20 lines in it that appear to be only camera values. If you open the whole-project 
XML, it will be much longer. 
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b. There is a new SimActive (third party UAV processing software) project import. Select Summit > Import > 
SimActive IEO and GCP or SimActive EOF and CAM, depending on which files you have. Set the 
project paths and specify a new Summit project name. Select the Create Summit Project button. To use 
the results, select Summit > File > Open and browse for the new project or drag and drop the new project 
into Summit. 

 

New SimActive project importer 

 

c. The DiAP project import has an additional variation for DiAP projects that have an absolute orientation 
defined in them instead of a set exterior value. 

d. Z/I imports will now correctly identify when a rotation of 270 degrees is required. 

 

 
Button Manager 

12. Button Manager. No changes. 

 

 
Lidar Image Generator 

13. Generate LIDAR Image (GenLidarImageUI[_64].exe) has the following changes: 

a. In previous versions, the output LAS format did not include color for the optimized files. Now it outputs a 
LAS format that has color. Optimized files are only created for larger files. Any user that already tried a 
previous version of GenLidarImageUI[_64].exe and wants to try the fixed version on the same file will 
need to remove the folder “…\OptPoints_tmp<>” before running the fixed LIDAR Imager creator. Note 
that if the folder is found, it will not re-run the optimization, but instead will use the existing files found in 
that folder.  
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Stereo Mate Generator 

14. Stereo Mate Generator has the following changes: 

a. The Stereo Mate Generator can now run in multiple instances. The purpose of running multiple instances 
is to increase the number of files that can be processed per hour. Note that the user is responsible for 
running the proper number and not exceeding the capabilities of the CPU. 

Try three or four instances to check the performance. DAT/EM recommends running no more than five 
instances at one time. If you try too many for the particular CPU, eventually the speed of processing will 
become slower, because all the CPU and disk access will be overloaded. When this happens, all the 
threads will run slower, resulting in all instances taking longer.  

The user must make sure that each instance does not process the same data. If multiple instances 
attempt to process the same file, it could crash.  

 

 
Contour Creator 

15. Contour Creator. No changes. 
 

 

Point Translator 

16. Point Translator 

a. See the “Coordinate Transformations and Elevation Database” section above starting on page 7. 

b. A problem reading and tiling .sdtm format files was fixed in Point Translator and LandScape. 

 

Project Viewer / Ortho+Mosaic 

17. Project Overview / Ortho+Mosaic has the following changes: 

a. Automatic seamline generation would crash in rare cases. The problem was related to the shape of the 
clip region between images. The workaround was to draw seams manually. The problem is now fixed. 

b. The Group will now be preserved if a Group model is open in Summit’s focus viewport and 
Ortho+Mosaic/Project Overview’s “Move Summit by Pick” tool is used. 

c. The Print View tool was fixed to show the images properly for video cards that have OpenGL version 4.2 
and higher. It will not work for video cards that have older OpenGL versions; for those older cards, 
DAT/EM recommends updating your video card. 

d. MrSid orthophotos in a Summit Orthophoto Feature Collection type project will now display correctly in 
Project Overview / Ortho+Mosaic. 
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LandScape 
The following changes were made to LandScape: 

1. A problem reading and tiling .sdtm format files was fixed in Point Translator and LandScape. 

2. Always load 100% is a new setting that can be accessed from the Tools menu and toolbar: 

  

“Always load 100%” is available when “Only Load Points Inside View” is on 

If this setting is turned on, LandScape will always load all the points in an area even if the view is zoomed out 
beyond that area. This setting is only available when “Only Load Points Inside View” is on. 

 “Always load 100%” off - LandScape begins thinning the loaded points as you zoom out to load 
a wider distribution of points. 

 “Always load 100%” on - LandScape estimates the maximum area that it can load 100% of the 
points in and uses that area, ignoring the current zoom bounds. 

 

3. Automatically Load on [points following] Move is a new setting that can be accessed from the Tools menu 
and toolbar. When it is on, LandScape will automatically load points as the mouse pans beyond points that are 
currently loaded. 

 

“Automatically Load on Move” on the Tools toolbar and pull-down menu 
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4. Interactive point editing 

  

There are changes to interactive point editing 

a. Tiling (operational concept) - Interactive point editing has been updated. It is no longer possible 
to load less than 100% of the points in an area while editing. To make this easier, tiling has been 
added as a default option for interactive editing. When the Interactive Point Editing dialog is 
launched, the project is broken into tiles. All the points will be loaded within each tile. Only one tile 
is loaded at a time.  

A tile may be selected using the Project Overview Window (see below), or by enabling 

Automatically load points following move (Tools toolbar) and panning into a different tile. 

Tiling may be toggled by selecting the  button (center of the Interactive Point Edit dialog). If 
tiling is turned off, the view will still be locked to 100% of the points. If turned off, the area will be 
selected based on the center of the viewing area and may be loaded using either the manual load 

button  or by enabling Automatically load points following move (Tools toolbar). 
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Edit Tiles in Overview window 

b. Edit using the system mouse (operational concept) - Beginning with 7.3, it is possible to use 
the system mouse when doing interactive point editing. The major difference between using a 3D 
cursor and the system mouse is that the 3D cursor is always moving in 3D space. The system 
mouse only moves in two dimensions when selecting points. One way to envision the difference 
is that using the system mouse is similar to pointing at an object through a window. Your hand 
moves along the glass to point at or select an object. When using a 3D cursor your hand is on the 
other side of the window actually touching the object being selected. When using a system 
mouse, LandScape will project the location of the mouse onto the underlying points, selecting the 
points the mouse is over. 

c. Streaming (operational concept) - creates the selection polygon used in most Interactive Point 
Editing tools. Due to speed limitations, streaming requires a 3D cursor. 

d. Face Shift shifts the project's points onto the surface (or face) of a TIN. When using the Polygon 
and Surface options, draw a boundary polygon around the area you would like to shift. If 
Polygon is selected, all points within the polygon are shifted to match the TIN created using the 
polygon. Surface provides the additional ability to measure points within the polygon that will also 
be added to the TIN used to shift the points. When using Line Offset, draw a baseline and then 
measure offset points that are used to create offset lines. The resulting lines combined with the 
baseline are used to create a TIN for shifting the points. If tolerance is set to a non-zero value, 
then any point within the tolerance value is considered close enough and is not shifted. If Show 
TIN is checked on, the TIN is displayed while the Surface and Line Offset points are collected. If 
New Class is set to anything besides No change or is blank, then that becomes the class of the 
shifted points. This new class value will only be written into the file if the file format supports it. 
Face Shift works best with a 3D cursor, but can be used with the system mouse. If the system 
mouse is used, then the boundary points will always be snapped to the existing point surface. 

e. Breakline modifies the surface in preparation for creating contours. It combines drawing a 
breakline using delete, shift, or change class, or using both shift and change class. Points within 
the Horizontal Distance and beyond the Vertical Tolerance of the line are considered targets 
and may be shifted, deleted, or have their classes modified. You cannot draw a breakline directly 
in the Profile View, but you can use the Drive profile view to cursor tool to view the profile view 
while collecting the breakline. This method only works with a 3D cursor, since the system mouse 
will always snap to the surface. 

f. Brush Z smooths small areas where the points are high or low. The Brush size defines a circle. 
Points within the circle are targets of the tool. Points bordering the circle are used to define a 
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surface. Target points are shifted to match the surface. If a point is already within Z Tolerance of 
the surface, it is not shifted. 

g. Add Point measures and inserts individual points into the project. The points are added to the file 
with the nearest file center. The Fixed Z option may be used to enter a fixed value as opposed to 
measuring the value with the 3D cursor. This tool does not use the system mouse. 

 

 

Add Point 

h. Profile Edit edits points in the profile view. To begin using Profile Edit, select the area of interest 
in the main view. When the Profile Edit tool is active, the default (left mouse click) action in the 
main view is to select a profile window. Once that is done the profile of the area will be visible in 
the Profile View. The mouse click action in the profile view depends on the Select profile points 
for editing selection in the top of the Profile Edit dialog. If Above or Below is selected, then all 
the points above or below the line created by selecting two points in the profile view will be 
modified. At this time only visible points will be modified. Points above or below the view will not 
be affected. If Rectangle is selected, a two-point rectangle is used to select a point region in the 
profile window. The points may either be deleted or their classes may be modified. Profile Edit 
only uses the system mouse and does not make use of the 3D mouse. 
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Profile Edit 

i. Set Z provides the ability to set the Z value of a group of selected points. The new Z value may 
be typed in by hand or measured using either the 3D cursor or system mouse. The class of the 
modified points may also be changed. 

 

Set Z 



DAT/EM Systems International Version 7.3 Release Notes 
 

 26 

j. Fill Points fills in or increases the density of areas that do not have enough points. To use: 

1) Set the Cell Size to the approximate distance between desired new points. If a point 
already exists in a cell, then no point will be added. 

2) Set the method for selecting the Z value of the new points. If Use boundary Z, or Z from 
TIN using surface points and boundary is selected, a TIN will be created and the new 
Z value will be based on the point’s location on the TIN. Fixed Z may be used to set a 
fixed Z value for all new points. 

3) (Optional) The Maximum randomized shift values may be used to add random shift 
values to new points. The XY value must be less than the Cell Size. There is no limit on 
the amount of Z shift. 

4) The New class setting controls the classification of the new points. 

5) Select the area to be filled using either the 3D cursor or system mouse. If neither 
Automatically apply on Cancel or Automatically apply when line crosses is selected, 
then press the Apply button to fill in the points. 

 

Fill Points is used to add points to a selected area 
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5. There are new LandScape system mouse options on the LandScape > Tools > Options > System Mouse page. 
 

 
New LandScape system mouse options 

 
a. The Display on Screen options control how the current shortcuts are displayed on the main 

screen. Options include text colors, text position on screen, and text size. 
 

 
Display on Screen options 

 
 

b. The Configuration and Mode options are a group of settings that (currently) include three 

modes of operation. The modes are Pan and Zoom , Rotate , and Edit , which are 

activated when the associated tool is selected. Configurations may be added , deleted , 

renamed , or copied . These options are not presently available for individual modes. 
 

 
Configuration and Mode settings 

 
 

c. The Mouse Button Configuration settings are composed of three parts. The mouse button 
action is controlled by a combination of a mouse button and the current state of keyboard shift 
keys. The Right mouse button is not programmable because it is used for context menus. New 
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actions may be added to the list using the [INS] key on the keyboard. They may be deleted using 
the [DEL] key. 
 
Valid states are Ctrl, Alt, Shift and any combination of the three. Change any of the options in 
the list by double clicking on the item to be changed. 
 
The Left, Center (press down on wheel), Four, and Five buttons are all available for 
programming. 
 
Pan, Rotate, Pick, Finish, Undo, Profile, and Zoom Window are valid button actions. At this 
time Pick is only valid while Edit is active. 
 

 
Mouse button configurations 

 
d. Wheel configurations have a key state identical to button configurations and a wheel action. 

Change Z, Zoom, Rotate, (Profile) Update Width are all valid wheel actions. Actions beginning 
with (Profile) are only possible when the cursor is in the profile window. 
 

 
Wheel configurations 

6. LandScape’s “Cleanup current project’s pyramid files” in v.7.2 could delete the entire folder, not just the pyramid 
files. This is fixed. 
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DAT/EM Capture for ArcGIS - ArcMap 
This version is compatible with ArcGIS 9.1, 9.2, 9.3 (service pack 1), 9.3.1(service pack 2), 10.0 (service pack 4), 10.1 (service pack 
1), 10.2, 10.2.1, 10.2.2, 10.3, 10.3.1, and 10.4 (plus any available service pack as they are released). 
 
BE ADVISED: In response to user requests, DAT/EM has decided to support ArcGIS 9.x with DAT/EM version 7.3. During the next 
release cycle, we will again review plans to drop support for ArcGIS 9.x. Please continue to make plans to upgrade any remaining 
ArcGIS 9.x version to 10.x. Contact DAT/EM if you have concerns about upgrading. 

Note: Blue Marble's Geographic Calculator ArcGIS plugin directly conflicts with DAT/EM's CaptureArcInfo.2010.dll. 
When DAT/EM software is installed, "Registration Failed" is reported near the end of installation. Run "C:\Program Files 
(x86)\Blue Marble Geo\Geographic Calculator\UnRegisterEsriPlugin.bat" before installing DAT/EM software. Contact 
DAT/EM for more information if you have Geographic Calculator and would like to use it in ArcGIS. 

The following changes were made to DAT/EM Capture for ArcGIS: 
Capture for ArcGIS subjects 

1. Multipatch layers are now compatible with Summit’s superimposition (SI). The ArcMap-side DAT/EM Options SI 
“Fill Polygons” option will be ignored for multipatch layers, because it increases the time it takes for Summit to 
load SI. If “Fill Polygons” is checked on, it will continue to work for non-multipatch data types. 

 

 

“Fill polygons” is ignored for multipatch layers, but still works for other data types 

 

2. Dual direction zoom matching is back by popular demand. In version 7.1 and earlier, it was possible to check on 
two settings to make Summit zoom the ArcMap view and to make ArcMap zoom the Summit view. This causes 
timing problems inside ArcMap while digitizing. Unintentional points or misplaced points could be added to the 
sketch. 
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Version 7.1 and lower zoom control settings could both be turned on at the same time. 
Timing problems could add unintentional or misplaced vertices to a sketch. 

To solve the problem in version 7.2, the settings were moved to the ArcMap-side Options dialog and only one 
application could control the zoom at a time. 

  

Version 7.2 restricted zooms to be controlled by either Summit or ArcMap, but not both. 

Although 7.2 fixed the unintentional/misplaced point problem, customers who do quality control instead of 
digitizing missed having both zoom matching controls. In version 7.3, the new “Summit and ArcMap both zoom” 
setting makes both zoom controls possible again.  

Note that the timing issues will still be present during sketching when the cursor reaches the edge of the view. If 
you have problems with unintentional or misplaced points added to your sketch, select only “Summit makes 
ArcMap zoom” or “ArcMap makes Summit zoom” to solve the problem. 

 

 

Version 7.3 can activate both zooms. Only use this setting if you are not having trouble 
with unintentional or misplaced points added to your sketch. 
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3. When Summit was set to use a system mouse digitizer and Capture for ArcGIS, the Windows system mouse 
arrow cursor could occasionally appear “glued” to Summit’s cursor in the Summit main view. This is fixed. 

 

4. A problem has been fixed as follows: A vector was being added between the last-digitized point when changing 
between a point layer with the DAT/EM point-to-point digitizing tool and a polyline/polygon layer with DAT/EM 
Autoarc digitizing tool. 

5. The “Show selected” tool now checks whether superimposition is on or off. If it is off, it will no longer cause the 
ArcGIS attribute field calculator to be extremely slow. If both “Show selected” and superimposition are on, it will 
still be very slow, and it is not possible to make it faster. To avoid slow processing when using the attribute field 
calculator, either temporarily turn off “Show selected” or temporarily turn off superimposition from the ArcMap side 
(turning it off on the Summit side will not help). The settings are as follows: 

 ;  

“Show selected” in the ArcMap-side DAT/EM options; “SI Off” on the ArcMap-side DAT/EM toolbar. 
Use one or the other to make attribute field calculations faster. 

 
Airfield3D for Summit Professional and Capture for ArcGIS 

6. Airfield3D: 

a. For non-vertically guided runways, Airfield3D previously ignored the RunwayEnd “Design Group” field, so 
that it always created the NVGAS surface starting at the end of the runway. That is only correct when the 
“Design Group” field is set to I (one), which means that it does not have a Specially Prepared Hard 
Surface (SPHS). 

The parser was fixed so that when the RunwayEnd “Design Group” field is set to II (two), which means 
there is an SPHS, the NVGAS will start 200 feet beyond the end of the runway. 

Note that the 18C update specifications clarify the rule about the SPHS and provide a good diagram.  
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To set a non-vertically guided runway to have an SPHS, set each affected RunwayEnd’s “Design Group” 
field to type II in the pull-down options for that field: 

 

For non-vertically guided runways with a Specially Prepared Hard Surface (SPHS), set the RunwayEnd 
Design Group field to II. This changes the NVGAS to start 200 feet beyond the end of the runway. 

b. There are new Airfield3D obstruction grid lines options.  

 

If a polygon on the ObstructionArea layer is selected, two previously hidden tools are enabled. The Grid 
Elevation tool isn’t new, but is reviewed again, since it is a key part of the gridding process. The Grid 
Elevation tool controls the elevation of the temporary grid to be drawn in Summit’s superimposition (SI). 

 None turns off the grid in SI. 

 Highest Point draws the grid at the elevation of the highest vertex in the selected 
ObstructionArea polygon. 

 Follow Surface adjusts the elevation of the grid to match the overlapping 
ObstructionIdSurfaces. 

Both Highest Point and Follow Surface have advantages depending on the terrain. 

 The Drive to Next Grid center   drives Summit to a point in the center of each grid 
element. This command can be assigned to the 3D cursor by adding a UserCAD command 
containing the string Next.  It can also be programmed into a Keypad button using the Next 
keyword. 
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 If the center of the grid is clipped out by the ObstructionArea polygon you will need to 
measure that grid manually. When all the points have been addressed the following dialog 
will be displayed. It contains a reminder to check the outer areas (possibly clipped areas) of 
the ObstructionArea polygon. 

 

 The Save Obstruction Grid   tool will bring up the following dialog: 

 

This dialog can be used to add all the ObstructionArea gridlines to a temporary shapefile and 
add that shapefile to the drawing. The Elevation options are the same as above without the 
None option. There is also an option to include the 10,200 circle in the saved data. To 
remove the gridlines from the drawing, just remove or clear the layer. 

c. When writing the surfaces to the ObstructionIDSurface layer, the VGPCS was being written as one large 
surface area that enclosed the VGRPS and runway. Now it is being properly written as two separate 
surfaces to either side of the VGRPS. 

d. The VGPS surfaces were at the wrong slope trajectory. They were taking on the same slope as the 
surrounding VGAS surfaces. Now they are defined properly.  

e. Summit could crash when the surface specification type was changed from 18B to Part77. This is fixed. 

f. Deleting previously created Part 77 surfaces now works better. 

g. Airfield3D will automatically turn off 3D snap when it starts. 

h. The definition of what is considered left and right of the runway was clarified by Mark Howard at NGS for 
one of DAT/EM’s customers. In summary: 

 VGRPS and VGPCS - left and right, as viewed from the high-numbered runway end 

 VGPS and VGAS - relative to an observer facing forward in a landing aircraft 

 VGATS - left and right as viewed from the high-numbered runway end 

 VGHS and VGCS - N/A [not applicable]. These are quadrants defined starting with #1 in the 
NE going counterclockwise. 

Summit now determines left and right accordingly. 
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DAT/EM Capture for ArcGIS – ArcGIS Pro (Beta) 
This beta version is compatible with ArcGIS Pro 1.1, the 1.1.1 patch, and 1.2. It is compatible with Version 1.2 only if the 
project coordinates are in meters. 

Important! DO NOT USE ArcGIS Pro 1.2 Beta if the Summit project’s coordinates are in feet. Version 1.2 Beta includes a Z 
coordinate conversion bug that incorrectly converts feet units into meters and leaves it as meters. We have reported the bug 
to Esri and await a fix in their next release.  

The following changes were made to DAT/EM Capture for ArcGIS Pro: 

1. Summit Evolution Z input will be incorrect if used with feet units and ArcGIS Pro version 1.2 Beta. Please check 
with DAT/EM when there is a higher version ArcGIS Pro available to see if Esri has fixed the bug. 

2. Three new keywords have been added to use with the DAT/EM Keypad Controller and Button Manager buttons: 

a. Toggle_streaming 

b. Toggle_tracing 

c. Toggle_squaring 

3. There is a new setting to specify the number of segments drawn in arc transient from ArcGIS Pro to Summit’s 
superimposition (SI). For large files, drawing SI transients is too slow, and this setting allows you to disable it. 

 

DAT/EM Capture and MapEditor for AutoCAD 
Changes apply to the following: 

32-bit AutoCAD 2004-2016 versions with the latest service packs. 

64-bit AutoCAD 2009-2016 versions with the latest service packs. Exception: 64-bit AutoCAD 2008 is not 
supported. 

BE ADVISED: DAT/EM Capture no longer supports AutoCAD 2000-2002 versions. If you use these older  AutoCAD 
versions, please upgrade to AutoCAD 2004 or higher before installing DAT/EM version 7.3. 

DAT/EM software will install for multiple AutoCAD products of different year numbers on the same computer; 
however, it will not install for multiple same-year versions together. For example, it will install for AutoCAD 2011 and 
AutoCAD Map3D 2012 together, but it will not install for both AutoCAD 2012 and AutoCAD Map3D 2012. Please note 
that files may be copied manually to activate more same-year versions (contact DAT/EM Support for instructions). 

Autodesk Infrastructure Design Suite installs three same-year AutoCAD versions (AutoCAD, Map3D, and Civil3D). 
You must run each version and register/”accept” each one before installing DAT/EM software whether or not you 
intend to run every version with DAT/EM Capture active. DAT/EM software will install completely for only one of them. 
After that, the user can manually copy the AutoCAD \datem folder and the wintab driver file into the other two versions 
of AutoCAD. Contact DAT/EM Support for instructions. 

Reminder: Install all available AutoCAD service packs and updates before installing DAT/EM software. 

Reminder: After every new AutoCAD installation, you must run AutoCAD at least one time to activate its license 
before installing DAT/EM software. This applies to every version of AutoCAD on the computer whether or not you 
intend to use every version with DAT/EM Capture. 

 

The following changes were made to DAT/EM Capture and MapEditor for AutoCAD: 
 

DAT/EM Capture for AutoCAD 

1. The intersection snap could miss the endpoint vertices of a polyline, depending on their order in the file. It wasn’t 
checking for segments that shared endpoints. This is fixed. 
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2. If a command such as MOVE or INS was waiting for a final pick point at the time the next model automatically 
loaded, the new model’s subsequent AutoCAD tablet calibration could fail (AutoCAD’s API would return a fail 
status, which was not visible to the user). The affected commands depended on the version of AutoCAD. To 
avoid this problem, digitizing will continue to function, but the AutoCAD view will delay matching Summit’s kappa 
rotation until the command is done. Once the command ends, it will perform the full orientation and the view will 
rotate to match Summit. 

3. In AUTOARC2D and AUTOARC3D, the snapping rubber band will now appear when the first point is snapped 
using snaps such as ENDP or NEA. 

4. AUTOARC3D’s “S” stroke distance setting is now retained for the next run of the command. 

5. DATPAN has updated prompts, but is otherwise unchanged. The prompts clarify what will happen when certain 
keyins are received. For example: 

 
Command: datpan 
Currently On. (blank return or letter O to toggle <Off>/On/Percent: 

 

6. SI SETTINGS "Clip Si" on caused missing SI vectors if polyline drawing was in progress when the next model 
automatically loaded. This is fixed. 

 

MapEditor for AutoCAD 

 

7. Densify is fixed so that it will not crash when a line segment is exactly divisible by the densify size. 

8. The MapEditor layer selection list refreshes more often. Previously, new layers could be missing from the 
MapEditor layer selection lists. 

9. Touch added a vertex at the right location, but wrote the new vertex into the polyline in the wrong order. This is 
fixed. 

 

DAT/EM Capture and MapEditor for MicroStation 
Changes apply to Capture for MicroStation. DAT/EM software installs for the following MicroStation versions on 
32-bit and 64-bit operating systems: 

 MicroStation V8 and V8 2004 Edition: Version should be 08.05.00.34 or higher. 

 MicroStation XM: Version should be 08.09.04.88 or higher. 

 MicroStation V8i, V8i-based Bentley Map and Map Enterprise SelectSeries 1 (1 not recommended), 2, and 
3; MicroStation PowerView SelectSeries 3; Power GeoPak* SelectSeries 3 

 PowerCivil SelectSeries 3 or 4 (but must be built after February 2010) 

If you upgrade from Select Series 1 to 2 or 3, you must reinstall DAT/EM software after installing the Series 
upgrade.  

DAT/EM will install for all versions of MicroStation that are present at the time of the DAT/EM installation. 
 
*Note about Power GeoPak Select Series 3: DAT/EM Software installs for Power GeoPak SS3, but has initial 
loading conflicts that affect the GeoPak and DAT/EM menus. Bentley has offered a workaround for this issue. If 
you have the Bentley Power GeoPak SS3 product, please contact DAT/EM for further installation instructions. 
*Note about Power GeoPak Select Series 4 (which runs with MicroStation Select Series 3): This product 
seems to be more successful running together with DAT/EM applications. There still could be issues. Please 
contact DAT/EM Support if using this version and having problems. 
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Note for MicroStation CONNECT Edition (64-bit MicroStation): DAT/EM version 7.3 does not contain an 
interface to MicroStation CONNECT Edition. We plan a limited beta interface available during the v.7.4 
development cycle. Please contact DAT/EM Support if you are interested. 

The following changes were made to DAT/EM Capture and MapEditor for MicroStation: 

 
General Subjects in Capture for MicroStation and MapEditor 

1. The buttons such as “Save” in the Parameter File Editor have been fixed to work more consistently. The save 
button will be active (black) when there are unsaved edits, and will be inactive (light gray) when there are no 
unsaved edits. Error handling was improved for the buttons overall. 

  

Save active when there are unsaved edits (left) and inactive when there are no unsaved edits (right) 

 

2. In previous versions, MicroStation line weight (wt) 0 and 1 looked identical in Summit’s superimposition (SI). Now 
you may consider wt=0 to have SI line weight 1, wt=1 has SI line weight 2, wt=2 has SI weight 3, and so on. Note 
that Summit’s Summit > Tools > Options > SI tab > Objects > Thickness can widen the lines by a factor. 

  
 MicroStation line weights 0, 1, 2, and 3 in superimposition  

Summit’s SI thickness factor enhances the difference between the weights 

 

3. The Selection Set Editor has stability enhancements. 

 

 
New Commands in MapEditor for MicroStation 

4. Status Banner is a new parameter file command that gives an overwriteable message dialog while MapEditor is 
running. The specified text string is overwritten with the most recent Status Banner text string. The dialog remains 
visible until you select “X” to turn it off. Status Banners may be used to show progress through the commands and 
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to give a finished message. For example, a status banner might print, “Finished Clip. Starting CrossCheck,” then, 
“Finished CrossCheck, starting next…” and so on until the last message, “MapEditor is finished.” 

  

 

Configuring banner messages in the Parameter File Editor 

 

While running this parameter file, a dialog appears in MicroStation. Each banner overwrites the one before it: 

  

Two example banner messages (only one dialog appears) 
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5. MEFINDDUPLICATES_VISIT <path and filename.xyz> is a new command variation of the Find Duplicates tool. 
It may be keyed in to the MicroStation key-in browser or added to a “Generic Keyin” line in the parameter file 
editor. It allows Find Duplicates to create a Visit file, which can be used by VISIT or “VISIT FILE <path and 
filename.xyz>” to go to the duplicate elements later. 

 

MEFINDDUPLICATES_VISIT <fielname.xyz> as a Generic Keyin command in a parameter file 

Note that there are some differences between the existing Find Duplicates (MEFINDDUPLICATES) and this new 
command. MEFINDDUPLICATES_VISIT logs entries for each overlapping element, both the original and the 
copy. MEFINDDUPLICATES_VISIT logs each overlapping element’s start, middle, and end points, which is 
consistent with other commands that log visit results. In addition, the (non-volatile) element Id (UID) is logged 
instead of the file position (FILEPOS), which can change between sessions. This will be used in later 
enhancements to VISIT to allow visiting elements instead of coordinates after the fact. 

 
Changes to existing commands in Capture for MicroStation 

6. 3DOFFSET had a problem when the offset would be a much smaller element, that is, where part of the original 
element needed to be cut off in the new element. The wrong elevations would be added to the new element. This 
is fixed. 

7. 3D to 2D (MECHANGETO2D) has several fixes, including: 

a. Improved error handling and robustness improvements, especially for the interactive version. 

b. Retaining dialog settings in the lower part of the dialog if they were made before the “Classes” or “Sets” 
buttons were used.  

c. Correctly processing the “Fixed Z” setting. 

d. Correctly skipping incompatible elements in the selection set, such as cells. 

 

8. AUTOARC has the following changes: 

a. AUTOARC has enhanced error handling. 

b. Accuracy in the Snap options (Break and Add Vertex at snapped to elements) was improved. 

c. A refresh was added at the end to ensure the newly drawn element fully displays in the MicroStation view. 

d. The Snapped To Element=Break setting could slightly move the endpoint (not the start point) of one of 
the newly broken elements. This is fixed. 
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9. CHECK ATTRIBUTES, Find Duplicates, and Visit no longer change the display depth when they zoom to the 
element extents. Previously, they would narrow the display depth range around the element extents. 

10. CROSSCHECK has the following changes: 

a. CROSSCHECK and other commands such as VISIT and ZCHECK had problems when the registry was 
cleared and active settings were set to ByLevel. Their marker dialogs crashed when initializing to active 
settings set to ByLevel. 

b. CROSSCHECK has a fix for the “break at intersection” function. It could bypass an intersection due to a 
great difference in size between the two intersecting elements. 

c. Diagnostics have been added to CROSSCHECK. 

d. A potential heap corruption error was eliminated and error handling was improved. 

e. CROSSCHECK’s Visit option was simplified internally and has improved error handling. 

f. The At Intersection=Break setting could slightly move the endpoint (not the start point) of one of the newly 
broken elements. This is fixed. 

11. CRSELECTION, which copies and rotates multiple selected elements to a new location, has a new option to show 
transient elements in Summit’s superimposition. Transient elements indicate the proposed new location and 
rotation of the elements before the final pick point is digitized. For performance reasons, it will only show up to 37 
linear elements. It will continue to copy and rotate selected arcs of more than 37 linear elements, but these will 
not be included in the transient element superimposition display. 

There are three new keyins to toggle the transient elements: 

CRSELECTION TRANSON – Turn transient element superimposition display on 

CRSELECTION TRANSOFF – Turn transient element superimposition display off 

CRSELECTION TRANSTOGGLE – Toggle transient element superimposition display 

  
CRSELECTION shows some of the selected elements as transients during placement; 

all the selected elements are copied when the final angle is selected. 

12. DATDRAW AUTOARC could result in the entire element disappearing when a single reset was accidentally 
followed by another command. With these commands, command termination could happen in two ways: two 
back-to-back resets, which worked to add the element to the file; or submission of a different command, which 
improperly terminated the Autoarc command and removed the in-process element from memory. Now command 
termination will have the same effect as two resets. The complete element will be written to the design before 
running the interrupting command. 
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13. DTMDISTRIBUTOR’s dialog had an error where settings may not have been saved or applied prior to execution. 
This is now corrected. 

14. FIX COMPLEX (MeFixComplex) could create nested complex elements when it should have instead simplified 
the element. This command has been rewritten to simplify the element when possible and verify sub-elements 
when elements remain complex. The command ensures sub-elements are snappable, have the same level and 
symbology as their complex header, and have their complex header recalculated in case there was a reduction in 
the number of sub-elements. 

15. FIND DUPLICATES has the following changes: 

a. FIND DUPLICATES, Check Attributes, and Visit no longer change the display depth when they zoom to 
the element extents. Previously, they would narrow the display depth range around the element extents. 

b. FIND DUPLICATES was not distinguishing between patterned and non-patterned elements that were 
otherwise identical (in Symbology and Geometry). A check was added to compare whether or not 
elements are patterned and, if matching elements are both patterned, whether they are patterned using 
the same cell. Other pattern attributes (such as hatch, offset, pattern rotation, etc.) are not considered at 
this time. 

c. Checks were added to ignore construction class and pattern components from consideration in duplicate 
element checks. 

d. MEFINDDUPLICATES_VISIT is a new command that allows users to search for and log duplicate 
elements from within a parameter file. This is described in more detail in item 5 on page 38. 

16. Log File: The MapEditor log file will be written during a MicroStation crash. 

17. MORPHOUT has been removed. It was obsolete. 

18. MicroStation’s PLACE SMARTLINE, PLACE LINE, PLACE SHAPE, etc., could be missing the rubber band in 
Summit’s superimposition if commands with cleanup functions had been run previously. This has been fixed for 
MicroStation XM, V8i, and SelectSeries-based products. This could not be corrected in MicroStation V8. 

19. RCENTERLINE has a refined algorithm to better handle test cases where the calculated center line gravitates 
toward one edge (for example, around sharp curves). Algorithm details: 

 Detects when the calculated centerline runs (>=10%) closer to one bank than it does to the other (at its 
nearest location to each bank). 

 Internally (but not actually) breaks both banks at approximately the location of nearest approach (to the 
nearest bank). 

 Re-runs RCENTERLINE for each (internally) broken bank pair. 

 Joins the centerline segments into a single (centerline) element. 

20. ROAD SETTINGS's Stroke Element option was fixed to properly save to and restore from .rcfg files. 
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21. SI SETTINGS has split the previously single "Show Line Style" setting into two separate settings: "Show Line 
Style" and "Show Line Weight": 

 

 

   

Left to right: “Show Line Weight in SI” only on, “Show Line Styles in SI” only on, and both on 

 

22. STROKE ELEMENT in a parameter file is now more efficient. Previously, very large data sets would take a long 
time to process or might crash after running out of memory. 

23. TOUCH BATCH has the following changes: 

a. Touch Batch has been fixed so that it can be run multiple times with the same parameters without 
encountering errors. 

b. There was an intersection calculation error on complex elements. Some versions of MicroStation have 
precision errors in calculating intersections with arcs in complex elements. To address this issue, Touch 
Batch internally strokes arcs in complex elements before calculating the intersection points. 

c. The Extend/Clip To element Options=Break setting could slightly move the endpoint (not the start point) 
of one of the newly broken elements. This is fixed. 

24. VISIT has the following changes: 

a. VISIT will no longer cause a view rotation when “Drive to” (drive Summit to point) is on.  

b. VISIT, Check Attributes, and Find Duplicates no longer change the display depth when they zoom to the 
element extents. Previously, they would narrow the display depth range around the element extents. 



DAT/EM Systems International Version 7.3 Release Notes 
 

 42 

c. VISIT and other commands that access the VISIT interface have two new marker settings: 

 No Marker - Used primarily with “Drive To” and/or “Element Extents”. No Marker is displayed in 
CAD or Summit. 

 Supress Marker in SI - A marker is displayed in MicroStation, but not in Summit’s 
superimposition. 

 

New marker options in Visit and commands that use the Visit interface 

 

d. VISIT and other commands such as CROSSCHECK and ZCHECK had registry initialization issues that 
caused their marker dialogs to have empty color, weight, and style list boxes, an inability to save changed 
settings, and crashes. The marker dialogs will now initialize correctly. 

25. VOLUME calculation (MeVolume), has the following changes: 

a. Results were improved for special test cases. 

b. Automatic Densification of lines that would otherwise “fall out” during triangulation. 

c. Addition of a “Weed” parameter for trimming surface tins to irregular boundaries.  

d. There is a new training video for MEVOLUME here: http://www.datem.com/training/ 

e. Diagnostics added to the interactive MEVOLUME interface [not available in batch (.PAR file interface)]. 
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When in Diagnostics Mode, interim calculation results are displayed graphically. No changes are made to 
the model or output file. Currently, there are three diagnostics available. 
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View Base Triangulation displays the pile base tins as calculated with the current parameter settings. 
For example, here is what the base triangulation for Pile 27 looks like with and without the Densify 
parameter set. You can see the benefit of the recent auto densify enhancement (no linear shelves are 
dropped during triangulation even without densify). 
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View Base Range Option shows the range used (clipping) performed during the base calculation. As a 
performance enhancement, base quantities outside this range are not considered in pile volume 
estimation. 

 

 
View Raw Normalized Surface Tins shows the raw surface tins with normalized elevation.  
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Below you can see the effect of surface boundary tracking and weeding. 

 
 

Diagnostic elements are removed by pressing the End Diagnostic Mode button. 

 
 

Diagnostics elements assume Active symbology and can be overlain. If you want to temporarily turn them 
off, they are at the “Datem Transients” Level and are not visible in Summit or in other DAT/EM products. 

The following picture shows surface triangulation in blue and base triangulation in pink. To get this 
overlay, set the active color to pink, run MEVOLUME for “View Base Triangulation” (without pushing the 
End Diagnostic Mode button), then set the active color to blue and run MEVOLUME for “View Raw 
Normalized Surface Tins”. 
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Additionally, there is a new “Write Diagnostics to Design” setting: 

 

If checked, MEVOLUME will place configured diagnostics (TINs, bounding string, etc.) in the master 
design at the current Active Level using Active Symbology. You may use this setting to look for something 
specific; for example, a gap in the input. 

This new feature can be paired with XYZOUT to export the results to an ASCII output file. The benefit of 
combining MEVOLUME diagnostics with XYZOUT is that you have more options, such as the ability to 
configure file output format. 
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26. XYZIN has the following changes: 

a. XYZIN has a fix for the default Cell name not being correctly set from the dialog. 

b. To place cells, it is no longer required to specify “CELL” and the cell name inside the input text file. If the 
file contains only x, y, z data and “Cell” is the only object type checked on in the dialog, a cell library will 
be attached and the default cell specified in the dialog will be placed at each coordinate.  

27. ZCHECK has the following changes: 

a. ZCHECK and other commands such as CROSSCHECK and VISIT had registry initialization issues that 
caused their marker dialogs to have empty color, weight, and style list boxes, the inability to save 
changed settings, and crashes. The marker dialogs will now initialize correctly. 

b. ZCHECK and other commands that access the Visit interface have new marker options: 

 No Marker - Used primarily with “Drive To” and/or “Element Extents”. No Marker is displayed in 
CAD or Summit. 

 Supress Marker in SI - A marker is displayed in MicroStation, but not in Summit’s 
superimposition. 

 

New marker options in commands that use the Visit interface 
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DAT/EM Capture for Blue Marble Global Mapper 
Changes apply to Capture for Global Mapper. Global Mapper 15 and 16.x dated after March 2, 2015 is supported; 
Global Mapper 17.1.2 or higher is supported and recommended. For Global Mapper 17 versions after the date of this 
document, please ask DAT/EM Support whether the version is expected to work well. 

Global Mapper versions and installation notes: 

 In November 2015, Blue Marble changed Global Mapper to be able to translate MicroStation DGN file text 
with elevation intact and to be able to handle multi-line text in a rotated view.  

 In March 2016, Blue Marble made changes to Global Mapper 17 to correct a problem in 
gm_GetActiveViewBounds. This corrected a synchronization problem between Global Mapper and 
Summit.  

 Use Global Mapper version 17.1.2 or higher, released 8 April 2016 or later. 

Note: For GM17 built earlier than 8 April 2016, DAT/EM 7.3 software may not register. If you attempt to 
register by hand, you may see the following error: 

 

Alternately, you may notice that the DAT/EM toolbar is missing. 

  

In either case, users wishing to run the DAT/EM extension with Global Mapper V17 should update to 
V17.1.2 or later. 

 Enabling the DAT/EM Capture Extension: DAT/EM’s Capture for Global Mapper extension is no longer 
enabled by default. To enable the extension, use DAT/EM’s CAD Enabler (Windows Start > All Programs 
> Datem Software > Utilities > CAD Enabler) set to Global Mapper = Capture. 
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CAD Enabler set to Global Mapper=Capture to register the extension 

 

There are installations where Global Mapper may appear to fail after software installation completes or 
CAD Enabler runs. An example of this failure follows. 

 

Potential crash due to problem in Global Mapper’s extension registration process 

If this error is encountered: 1) Verify that the version of Global Mapper is version 17.1.2 or higher. 2) Run 
Global Mapper and check for the DAT/EM toolbar. If the toolbar is there, the installation was successful 
and you can disregard the error. 3) If the toolbar is missing, the extension can be enabled by opening 
Global Mapper and before opening any data files, select Global Mapper > Help > Module/Extension 
License Manager > check “DAT/EM Capture for Global Mapper (version)” in the right pane. 

 

If the DAT/EM Toolbar is present, the registration succeeded 

 

 Disabling the Global Mapper Extension. Once the extension has been successfully enabled, users 
wishing to disable DAT/EM’s Global Mapper extension should use DAT/EM’s CAD Enabler set to Global 
Mapper = Disable. 
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CAD Enabler set to Global Mapper=Disable to unregister the extension 

 

If an error is encountered and the extension is not disabled, the CFG file can be edited to remove the 
extension. 

 Global Mapper version 17.2 and higher has a new function that allows DAT/EM’s “Global Mapper makes 
Summit zoom” setting to work without the cursor jumping in the Global Mapper view. If using 17.1.2, 
please set the “Summit makes Global Mapper zoom” setting to avoid this problem. For more information, 
see item 6 on page 55 below. 

 

The following changes were made to DAT/EM Capture for Blue Marble Global Mapper: 

1. Version 7.3 is the first version to be installed for Global Mapper 17. If Global Mapper 17 is the only version of 
Global Mapper on the computer, DAT/EM will install a new extension that uses Global Mapper’s v.17 API. If v.16 
and/or v.15 are also on the computer, the older extension using the older API will be installed for all versions. 
Please note that Global Mapper v.17.1.2 or higher is recommended due to synchronization issues in previous 
versions of Global Mapper. 

2. There is a new DLL built with Global Mapper’s V.17 SDK. Please note that the V.17 SDK was released later than 
Global Mapper v.17. From the user’s perspective, it should not matter which DAT/EM DLL is in use; the older DLL 
will still be used for older Global Mapper versions and for systems that have multiple Global Mapper versions 
installed, including a version older than 17. The new DLL will be used only when v.17 is the only version of Global 
Mapper installed. Please note that Global Mapper v.17.1.2 or higher is recommended; earlier versions of Global 
Mapper 17 had synchronization problems. 
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To see which extension version is running, select Global Mapper > Help > Module/Extension License Manager: 

 

 

The DAT/EM multi-platform DLL appears as “DAT/EM Capture for Global Mapper”: 

……….. 

Old DLL that uses the pre-v.17 SDK 

The new DLL that uses the v.17 SDK appears as “DAT/EM Capture for Global Mapper 17”: 

 

New DLL that uses the Global Mapper v.17 SDK 
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3. Global Mapper v.16 no longer re-centers the display. This is to work around v.17 coordinate mapping issues. 

4. 2D and 3D streaming are new drawing tools. Streaming is a free-form drawing style similar to Global Mapper 
Trace Mode drawing, but with 3D Summit-based digitizing and configurable settings. 

 

Streaming Draw Tools 

 

Line Stream Settings should be configured prior to digitizing. Select Line Stream Settings from the DAT/EM 
Draw Tools dialog and make the settings: 

 

Line Stream Settings should be configured prior to digitizing. 

 

When drawing in 2D, vertices will be added based on XY segment length using the following parameters: 

 Maximum segment length – a vertex will automatically be added if the length of the current segment 
reaches this length. 

Note that if the monotonicity setting is on in the 2D or 3D streaming tool, it overrides the 3D streaming 
maximum segment length setting when the elevation check does not allow a vertex to be added. 

 Minimum segment length – when the current segment reaches this length, the deflection angle will be 
used to determine whether to add a vertex. 

 Add segment after deflection degrees in XY – a vertex will be added if the angle of the current 
segment reaches or exceeds this threshold. 
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When drawing in 3D, vertices may be added based on a Z change, an XY change, or an XYZ change. 

After the desired stream settings have been configured, 2D or 3D streaming can begin. 

2D Streaming 

Select 2D Streaming from the 
DAT/EM Draw Tools dialog. On start, 
the 2D stream dialog allows the user 
to configure the type of feature to be 
created. 

3D Streaming 

Select 3D Streaming from the 
DAT/EM Draw Tools dialog. On start, 
the 3D stream dialog will allow the 
user to configure the type of feature 
that will be created. 
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5. The DAT/EM Keypad tools have been improved for use with Capture for Global Mapper. DAT/EM encourages 
you to select “DAT/EM Keypad” during software installation, even if you don’t have the DAT/EM Keypad 
hardware. If “DAT/EM Keypad” was not selected during installation, you can start it manually from "C:\Program 
Files (x86)\Datem Software\KeypadController.exe". Anyone may use the Keypad Controller on screen, even 
without the Keypad hardware. The Keypad for Global Mapper has the following changes: 

a. The new point streaming commands mentioned above have been added to the example keypad 
configuration that is installed, "C:\ProgramData\Datem Systems\keypad\GlobalMapper.dkf". 

 

Streaming tools on the example DAT/EM Keypad overlay 

b. The following is the keyword list to be used for the DAT/EM Keypad and Button Manager buttons, 
including new and existing keywords: 

DeleteObject 

Draw Line2D 

Draw Line3D 

Draw Stream2D 

Draw Stream3D 

Draw StreamSettings 

Draw Spotx 

CallCommand MoveToCmd 

CallCommand StopMoveToCmd 

CallCommand Close  

CallCommand Open  

Cancel  

FitView 

RefreshView  

SI On 

SI Off 

SI Update 

ToggleDatemCursor 

Undo – Limited to ongoing digitizing 

ZoomPlotter 

 

In addition, you may use the DAT/EM Keypad to call your own Global Mapper Scripts (refer to 
http://www.bluemarblegeo.com/knowledgebase/global-mapper/ScriptReference.html). In the DAT/EM 
demonstration DAT/EM Keypad .dkf file for Global Mapper, keys 225 (Script Demo) and 226 (Macro 
Demo) illustrate this. 

 

c:\classBuildings.gms (script demo key on left) and EDIT_VECTOR FILENAME=* 
AREA_TYPE="Building - Ground" COMPARE_STR="DGN_LEVEL=33" (macro demo key on right) 

6. Capture Settings Options in Global Mapper have a new setting to specifically allow Global Mapper to match 
Summit’s zoom or Summit to match Global Mapper’s zoom. A sliding scale has been added to allow a relative 
view zoom, for example, to have Global Mapper more zoomed out relative to Summit. These changes solve the 
problem where Global Mapper had trouble keeping up with the clutched zoom (on a dedicated 3D input device in 
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Summit) followed by a pan. Summit would unintentionally zoom in when Global Mapper panned due to timing 
issues of both Summit and Global Mapper controlling each other’s view zooms. 

Note: Global Mapper version 17.2 and higher has a new function that allows the “Global Mapper makes Summit 
zoom” setting to work without the cursor jumping in the Global Mapper view. If using v.17.1.2, please only use the 
“Summit makes Global Mapper zoom” setting to avoid this problem. (Do not use versions of Global Mapper 17 
lower than 17.1.2.) 

 

 

New zoom methods in Capture for Global Mapper 

 

7. Global Mapper 17 introduced a difference that made DAT/EM’s interactive editing commands stop working. 
Element selection information could no longer be retrieved (related events were not received and when the 
nearest feature information could be retrieved, it was often for the wrong feature). DAT/EM reported this to Blue 

Marble and implemented a workaround. It now requires users to run the Feature Information Tool  or <Alt>P 
and double click on features to be edited. On click, Capture now checks for selected (highlighted) elements to 
edit. Edit dialogs remind users to start this tool: 

 

Edit dialog reminds users to start the Feature Information tool 



DAT/EM Systems International Version 7.3 Release Notes 
 

 57 

8. The most recently used DAT/EM drawing tool will still be highlighted the next time the DAT/EM Draw Tools dialog 
appears in the current Global Mapper session. 

9. The DAT/EM digitizing tool will no longer switch between closed areas and open lines when resetting the layer 
setting. 

10. Repeatedly changing the status of the “Snap Ends” checkbox in the Digitized Feature Settings dialog could make 
the “Z sequence” (monotonicity) setting menu disappear. This is fixed. 

11. A problem was fixed where the data would not be placed on the layer that was selected in the drawing tool. 
Instead, it would be placed on the last layer that was used in a Global Mapper (rather than DAT/EM) drawing tool. 

12. Hint (not a change): In case of multiple lines of text to display in superimposition, the Global Mapper version will 
need to be 24 November 2016 or newer. Note that DAT/EM recommends 8 April 216 or newer for other reasons. 
Make the following setting: Global Mapper > Tools > Configure > Vector Display tab > Always Display all 
Labels. 

  

 

 

-End- 


